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Introduction/Overview -1 
Jul. 16, 2012Paul Thurrott | Paul Thurrott's Supersite for Windows 

With Office 2007, Microsoft stunned virtually everyone who’d used the company’s best-selling 
productivity suite by switching from the traditional and familiar menu- and toolbar-based user interface 
to a new ribbon interface. The move was controversial but sound, and the ribbon has indeed made it 
much easier to find previously-hidden commands and features. Office 2010 finished this move to the new 
UI, and formalized how the ribbon could work consistently across multiple applications. 

So what does Microsoft have up its sleeve for Office 2013? 

A lot. 

Looking at the desktop applications generally, the biggest and most obvious change with this generation 
of products is the move to a flat, clean and Metro-like user experience that will be at home next to both 
traditional desktop applications and new, (and true) Metro-style apps.  

 

As with the previous move to the ribbon, I like this change a lot and embrace it wholeheartedly. Like 
many, I live in Office every day, particularly Word, and I find the Metro ideals that come through in Office 
2013—mostly the ability of this new style to “get out of the way” and help you focus on what you’re 
working on, and not the surrounding application chrome—to be quite successful.  

This is interesting and even surprising because most of the Office 2013 still require and display an awful 
lot of UI. Those ribbons are fairly bristling with commands and in most applications you’ll want to leave 
the ribbon visible, though minimizing it will of course result in a cleaner—and ostensibly more “Metro-
like”—look and feel.  

(In some applications, like Outlook, the ribbon is indeed minimized by default, and this does go a long 
way towards making them seem less complex. And then of course Microsoft has created two actual 
Metro-style apps for Office 2013, OneNote RT and Lync RT, which I’ll look at in more detail separately 
later.) 

There’s also a subtle but nice use of color to differentiate the Office applications, and so if you move 
between, say, Word, Excel, and PowerPoint over the course of the day, you’ll grow to associate them 
with their respective colors, which are blue, green, and orange. And you can use those colors to more 
quickly pick the application you want out of Windows (many) task switching UIs (particularly in Windows 
8). 

Microsoft took the Metro look of things to the Office application icons too, of course, which sport a nice 
modern and flat look. 

http://winsupersite.com/author/paul-thurrott
http://www.windowsitpro.com/windows-8
http://www.windowsitpro.com/windows-8
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Key new and improved features across most Office 2013 applications include: 

Account integration. Office 2013 now fully integrates with various cloud services and the online accounts 
that are associated with them. For most individuals, this will mean associating with your Microsoft 
account (currently called Windows Live ID) and thereby gaining access to your SkyDrive based storage 
directly from within Office. Indeed, SkyDrive is the default save point for Office applications if you 
configure such an account. (Relax, you can change it.) Office also connects to Office 365, My Office 
(basically the same thing as SkyDrive), SkyDrive Pro, and for purposes of inserting content even third 
party services like Flickr and You Tube. 

Backgrounds. While the Office 2013 applications sport a flat look, Microsoft does let you embellish them 
a bit with a background pattern if you want. (Oddly, the background is one of the few choices you make 
during Setup.) Six are included—Calligraphy, Circle and Stripes, Circuit, Clouds, Straws, and Tree Rings—
and you can of course choose not to use a pattern if you’d like. These patterns are vaguely reminiscent of 
the background patterns Microsoft provides for the Windows 8 Start screen, though oddly none of them 
match up. 

Start experience. Microsoft introduced the Backstage user interface in Office 2010, providing a pretty 
consistent full screen “File” experience, with New, Open, Save, Print, Share and related options all 
gathered together. In Office 2013, Microsoft is introducing a new full screen Start experience for its core 
Office 2013 applications--Word, Excel, PowerPoint, and so on—that mimics Mac:Office by providing 
upfront document templates for you to choose from. If you find this thing tedious, tapping Enter will get 
you directly to a new blank document/presentation/worksheet/whatever since that’s the default choice. 
Or, you can simply disable the Start screen in Options and get on with life. 
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Alignment guides. Many of the core applications, including Word and PowerPoint, provide new and very 
useful alignment guides that show up when you position charts, photos, and diagrams in a document. 

 

Online pictures support. Many of the core applications, including Word and PowerPoint, support online 
pictures sources such as Office.com clip art, Bing Pictures Search, Flickr, and SkyDrive in addition to 
letting you insert photos and other pictures from your own PC or local network. 

Resume reading. Many of the core applications, including Word and PowerPoint, will automatically 
bookmark your last position in a document so that the next time you open it you can pick up where you 
left off. 
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Introduction/Overview -2 
By Dana Wollman posted Jul 16th 2012 3:00PM 

Preview 

 

It's been about three years since Microsoft unveiled a new version of Office, and particularly with 

Windows 8 just months away from dropping, the software has been well overdue for an upgrade. 

Today, Redmond unveiled the latest edition -- Office 2013 (aka Office 15) -- which the company will 

be showing in a preview stage until the final version goes on sale (hit up the source link if you want 

to download it for yourself). 

Perhaps the biggest news isn't any single feature Microsoft's added to Word (hello, easy YouTube 

embeds!), but how and where you'll access your files. With this version, the company is moving to a 

subscription-based model wherein your Office files are tied to your Microsoft ID. Once you sign up, 

you can download the various desktop apps to a certain number of devices and, as with Windows 8, 

your settings, SkyDrive files and even the place where you left off in a document will follow you from 

device to device. (It's telling, we think, that files now save to the cloud by default.) As you'd expect, 

too, this version is also more tablet-friendly than editions past, with a touch mode that widens the 

spacing between onscreen objects and flattens menus. In Word and PowerPoint, you'll also find a 

read-only mode that turns documents into full-screen editions, whose pages you can swipe through 

as you would an e-book or digital magazine. 

Of course, Microsoft included plenty of granular updates like PDF editing and a behind-the-scenes 

Presenter View in PowerPoint. Fortunately for you, curious power users, we've been spending the 

better part of a week testing the software on a Samsung Series 7 Slate loaded up with Windows 8. 

So join us past the break where we'll give you a detailed breakdown of what's new, along with 

screenshots and detailed first impressions. 

http://www.engadget.com/editor/dana-wollman
http://www.engadget.com/tag/preview
http://www.engadget.com/tag/Office15/
http://www.engadget.com/2011/12/16/samsung-series-7-slate-pc-review/
http://www.engadget.com/editor/dana-wollman/rss.xml
http://www.engadget.com/2012/07/16/microsoft-office-15-preview/
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General look and feel 

For those of you who thought Microsoft would completely overhaul Office ahead of the Windows 8 

release, let's put it this way: if you could survive the transition to Ribbon menus in Office 2007, you'll 

quickly feel at home here. The Ribbon is, indeed, still the cornerstone of the Office experience, the 

visual metaphor permeating Word, Excel, Outlook and every other application in the suite. 

Nonetheless, Microsoft has made some subtle changes to the UI, and they're all quite important. For 

starters, no matter what app you're using, you'll find your name and Microsoft account photo in the 

upper-right corner -- a reminder that the cloud is now the linchpin to the Office experience. From 

there, you can click the photo to adjust your account settings, swap in a new picture or even switch 

accounts. 

Cloud integration 

 

Being able to save to the cloud is hardly a new feature in Office, but for the first time saving to 

SkyDrive is the default, not the C drive. (SkyDrive Pro support is coming as well, says Microsoft.) And 

when you do hit save, you'll even see a progress bar on the bottom of the screen, confirming your 

latest draft made it safely to the cloud. As you'd expect, of course, the built-in options for saving to 

the cloud are limited to Microsoft's own services (SkyDrive and SharePoint). If you want to upload to 

Dropbox or Google Drive, you'll have to do it outside Office. 

And since your files are stored online by default, it's fairly easy to share them on the web as well. 

Throughout these various Office apps, you can share your work with someone by sending them a 

URL, allowing them to follow along in a browser even if they don't happen to have Office installed on 

their local machine. To do this, just hit File, Share and choose either "Get link" or "Invite people," if 
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you want them to have editing privileges. If, for some reason, the version fails to upload, you'll see a 

banner stretching across the top of the screen, prompting you to try that save again. From the same 

sharing menu, you can also post your work to a social network or email a document as an 

attachment, but that last bit isn't new. 

Another perk: a feature called Resume Reading allows you pick up exactly where you left off, even if 

you resume editing on another device. (Okay, okay, Amazon's Kindle, for one, already bookmarks e-

books this way, but isn't it a relief not to lose your place in a 44-item slide deck?) Though this feature 

doesn't apply to most apps in the Office family, you will see it in Word as well as PowerPoint. 

Lastly, in various Office apps it's now easier to toss in a photo you found online. For example, Word 

is now integrated with Facebook and Flickr so that you pull pictures straight from there, instead of 

having to download it and then manually insert it into the doc. Obviously the only caveat is that you 

need an internet connection, so maybe save a Disney World photo or two on your desktop for 

offline emergencies. 

Touch mode 

Microsoft has made some subtle changes to the UI, and they're all quite important. 

Across the various apps, too, you can use a new touch mode to make the software a little more 

finger-friendly. To expose this option, click on that small arrow in the upper-left corner of the screen 

-- you know, the one you already use to customize which icons are visible and which ones are 

hidden. Once you select touch mode, the icon that appears should look like a circle with a dotted 

line around it. 

It's easy to imagine that, with the press of a button, Office would somehow take on more of a 

Metro-inspired look, with large, finger-friendly icons and -- dare we say it -- a more dumbed-down 

interface. Actually, the adjustments Office makes in touch mode are far more subtle. In short, 

enabling this mode widens the spacing between onscreen objects, making it less likely that you'll tap 

the wrong thing. This mode also causes various menus to flatten so that you can see options with 

less finger input involved. Again, that doesn't mean the objects on screen suddenly become larger to 

accommodate finger input, but this mechanism at least cuts down on the amount of tapping you'll 

end up doing. 

Etc. 

Spend enough time in Office 2013 and you'll notice dozens of visual flourishes that serve to give the 

software that extra bit of spit and polish. Office comes bearing glossy new icons, for one. Different 

apps like Word and PowerPoint have improved alignment guides, which become visible when you're 

inserting tables and other objects (we first noticed this while inserting a YouTube clip). 

Also, animated transitions are everywhere: a slide of the screen when you hit the File tab, Excel 

charts growing before your eyes. As a Microsoft rep explained it, the idea is to offer some visual 

feedback to new users, who might not totally know their way around yet. Whether you require that 

kind of babying is debatable, but we're sure of this much: the animations are slick -- pretty, even -- 

and everything about the suite feels fast: fluid, brisk and refreshingly devoid of bugs. 
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Getting started 

This isn't your old-school software installation, kids. The beauty of Office 2013's software-as-a-

service model is that you get automatic updates and all that jazz you've come to expect from the 

other web-based services in your life. So it's fitting, then, that the installation begins not with a 

software download, but by selecting your preview version and then signing in with your Microsoft / 

Windows Live ID. Wait a few minutes for the setup to unfold, and then download Office to your 

various devices. (Take note: Office 2013 will run on Windows 7 and the Win8 Release Preview; it's 

not compatible with Vista, and it won't work with earlier builds of Windows 8, such as the Consumer 

Preview.) Armed with a speedy WiFi connection, we were up and running in five minutes and, again, 

the experience was smooth and crash-free. 

This might be a good time to clarify the minimum hardware requirements. So long as you have 

3.5GB of free disk space and an X86 or X64 system clocked at 1GHz or higher, you should be good to 

go. DirectX10 graphics are required, along with a minimum resolution of 1024 x 576. Microsoft also 

recommends 1GB of RAM for 32-bit systems, and 2GB for 64-bit machines. 

Word 

Look and feel 

 

When you open Word for the first time, you'll notice some changes to that introductory start page. 

Now, the left-hand pane shows recent documents, while the area to the right showcases templates, 

some of them new. Of course, the thing you'll probably want most – a blank document – is still 

sitting in an easy-to-spot corner, toward the top of the screen. 

Head on into a blank document and you'll see the Ribbon UI has made room for a new Design tab, 

which claims to let you make all your design changes in one place. Options include things like fonts, 

paragraph spacing, themes and adding watermarks to documents. Thankfully, though, Microsoft 
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kept the feature where if you highlight text and then hover over it with your mouse, you'll see some 

pop-up controls right there, allowing you to change the font color and make other simple tweaks. 

Tracking changes 

 

Of all the new features in Office 2013, this is the one we Engadget editors hold dearest to our hearts. 

With this version of Office, tracking changes has been tweaked so that unless you're actively reading 

through changes and comments, all that noise simply shows up as a bunch of red lines. When you're 

ready to focus on editing, just click the line to expand the thread. And we do mean threads. Now, if 

you get into a back-and-forth with another editor ("Can we call this phone a Galaxy Note clone?" 

"No"), those comments will appear in a single conversation that flows alongside the page, in the 

margins. If you've ever used track changes to collaborate on a document, you know that previously 

such an inane exchange would mean seeing a separate comment bubble for each person's response, 

even if they were all addressing the same issue. 

And control freaks, rejoice: you can now lock tracking, which means someone needs to enter a 

password to make Word stop tracking changes. The point being, unless that person knows the 

password, he or she can't make any changes without you knowing. 

Live Layout and adding online video 

It's not like you couldn't previously add online 

video to an Office document, but it was a pain -- 

hardly a beginner-level move. Now, Word allows 

you to insert clips directly from YouTube, Bing 

Video or any other site, so long as you have the 

HTML embed code handy. Just click the Insert 

tab in the Ribbon, then click – you guessed it – 

"Online Video." Again, if we wanted we could 
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paste in some code from Viddler, Engadget's hosting site, and insert a review video we had already 

uploaded. For the purposes of this walkthrough, though, we'll pretend we're searching for 

something on YouTube. 

When you search, the results appear in a small pop-up that obscures the screen (not a browser pop-

up, but a dialog box within Word). All of the search results appear as small thumbnails, and if you 

hover over them, you can see the title of the video (how else are you supposed to know if you've got 

the auto-tune remix?). Helpfully, you can also see how long a video is, so if you were looking for a 

music video, say, you might have an easier time weeding out the 50-second ones that obviously 

aren't complete. You can also preview the video first so that you don't go through the hassle of 

embedding it only to realize it's not what you wanted. 

Once you insert the video, it's easy to resize it by dragging the corners or sides. There are also little 

pop-up tabs next to the frame, which you can click to select a layout option (e.g., in line with the 

text) or do things like cut or copy it. In theory, you can also watch a video from inside Word, without 

having to open up the browser. It doesn't bode well, though, that the first video we inserted had its 

permissions set in such a way that we had to visit YouTube if we were going to watch. Unfortunately, 

there's no way of clarifying that before you insert a video. 

Also, in a new feature called Live Layout, the text will automatically wrap itself around a video, chart 

or anything else you insert into the text. And that happens in real time, even as you drag the object 

around. This is what we mean when we talk about Office's solid performance: as impressive as these 

new features are, they feel remarkably lightweight and nimble. 

Editing PDFs 

 

For a while now, Word has allowed users to save finished docs as PDF files. But until now, doing the 

opposite -- editing a PDF -- has required additional software, much of it not free. Here, though, when 

you open a PDF you can edit it as you would a Word document, and then you can either save it as 

such, or save it as another PDF file. We had no problem taking a PDF email attachment, typing in 
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additional material, saving it as a PDF and then viewing it in Windows Reader. Okay, depending on 

who you are this might not be the most exciting new features in Office 2013, but it is certainly one of 

the most useful. 

Reading mode 

 

Now here's a feature Microsoft might not have bothered to include if it didn't imagine people using 

Office on tablets. The company's added a new reading mode -- a full-screen, read-only view that 

mimics the experience of reading an e-book on a tablet. To enter it, just go to the View tab in the 

Ribbon and find "Read Mode" all the way on the left. (Psst: This works in PowerPoint, too.) 

Once you're in, the document takes up the whole screen, save for the Windows taskbar at the 

bottom. Like an e-book -- but very much unlike a Word document -- the pages scroll from side to 

side by default, instead of top-to-bottom. (If you like, you can switch to a so-called page view with 

vertical scrolling.) All told, it's very intuitive to find your way around: there are onscreen left and 

right arrows, which you can click, but you can also just swipe the screen to advance to the next page. 

You can also adjust the color of the text: it's black-on-white by default, but you can also choose 

white-on-black or a sepia theme. 

Lastly, when you're in reading mode, there's a separate feature called Object Zoom, which allows 

you to expand a photo or table within the text by double clicking or tapping it. Like any good e-

reader app, you can also search for specific words in the text, or perform a search (in this case, with 

Bing). 

Onscreen keyboard 

Sticking with this tablet theme for a moment, Microsoft built in the same well-spaced touchscreen 

keyboard you'll find in Windows 8. We especially appreciate that the apostrophe is to the right of 

the "L" key, as it is on a physical keyboard. There's also a visible Ctrl key so that you can press Ctrl + S 

to save your work. Lastly, we had a good experience with the predictive spelling, which presents 

suggestions in the form of small, unobtrusive pop-ups. 
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Excel 

Flash Fill 

 

We can remember a time when Sparklines, those charts-within-cells, were the marquee new feature 

for Excel. This year, though, you'll notice that many of the major new additions don't necessarily aim 

to jazz up spreadsheets so much as take the tedium out of the number-crunching. Exhibit A: Flash 

Fill. It's a feature that recognizes your data patterns to the point where it should be able to predict 

what belongs in the remaining blank cells and fill them in for you. For example, if you were to make 

a spreadsheet detailing on what days different departments were using the main conference room, 

Excel would eventually pick up on the fact that every marketing executive has a meeting there 

Tuesday, while the publicity people are due there on Thursday. 

In theory, you just have to enter some of that data and then go to the Data tab, where you press the 

Flash Fill button to make it fill in the rest. For instance, in a demo spreadsheet provided by 

Microsoft, one column shows a list of company email addresses, each of which follow the format 

"firstname.lastname." After typing two first names in the blank "First name" column, Excel filled in 

the rest. Ditto when we added a column for last names. 

In our own testing, we enjoyed similar success, but discovered that Flash Fill doesn't make sense of 

all data -- for example, it doesn't recognize "yes" and "no" as values. So, there might well be times 

when Excel won't be able to survey your data set and pick up on the patterns within. 
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Suggestions for visuals 

 

Fortunately, Excel includes some new features that prove to be a little more intelligent than Flash 

Fill. These include recommendations for so-called PivotTables as well as charts. Using the data we 

just talked about (employees, their departments and their health insurance status) the 

Recommended PivotTable feature (located under the Insert tab) came up with a few logical options: 

employee count by department, and a count of insured versus uninsured workers. Sounds right to 

us. Likewise, the Recommended Charts feature (also in the Insert section) offered up the same ideas, 

only represented in pretty bar graph form. 

Timeline Slicer 
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A new addition to Office's collection of so-called Slicers, Timeline allows you to filter data by certain 

time periods (think: sales data for 2011). 

Quick Analysis 

 

Though the name would suggest otherwise, this feature isn't so much a shortcut for making sense of 

your data as it is a way to preview different visuals. As you can see in that screenshot above, once 

you click on the corresponding Quick Analysis icon you'll see various formatting options, and as you 

hover over them you'll see the document change accordingly, giving you a glimpse of what you'll see 

if you end up selecting that option. 

PowerPoint 

Presenter View 

So no fancy new charts in Excel, but lots of 

ways to make sifting through your data a 

little more efficient. It's a similar story with 

PowerPoint: even more than animated 

transitions, Microsoft is focusing on behind-

the-scenes features designed to take some 

of the anxiety out of presentations. For 

starters, when you plug in a projector, Windows will automatically extend your desktop onto that 

larger screen so that you don't have to fiddle with the setup in front of your audience. 

Once you're plugged in and ready to start your talk, you'll have the option of using a new presenter 

view, visible only on the screen you're using (press Alt + F5 to bring it up). Not unlike the presenter 

screen in Apple's Keynote software, this shows you the time elapsed, as well as any notes you may 

have written yourself. You can also enlarge text, teleprompter-style and pinch the slider to see the 

full slide deck -- very similar to how you can pinch to get a bird's eye view of your Windows 8 Start 
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screen. The idea, says Microsoft, is to be able to nimbly skip forward a few slides if someone in the 

audience asks a question about some topic you haven't gotten to yet. If you do rearrange the slide, it 

won't be visible to the audience on the big screen. None of the behind-the-scenes stuff will be. 

As ever, you can also scribble, or "ink," on slides using either a pen or your finger. (You'll have to tap 

an icon first to enable this.) You'll see this as an option under the Review tab when you're marking 

up slides, but you can also do it during your presentation, from the Presenter View screen. 

Miscellaneous 
The rest of the new PowerPoint features are a motley bunch. You can merge shapes to create 

custom ones. In addition to using an eyedropper to select colors, you can also match a color to an 

accompanying photo. Music playback has also been improved so that you can now play a track in the 

background across multiple slides or the whole presentation. Additionally, Microsoft has expanded 

its list of supported media file types to include .MP4 files, meaning you can export to .MP4 as well as 

play such files natively without having to install QuickTime. 

Outlook 

Look and feel 

In its current incarnation, Outlook still looks like, well, Outlook, but you'll notice that many of the 

options aren't immediately visible. Much like there's no fixed Start button in Windows 8, the flags in 

Outlook only appear if you hover next to a message with your mouse. Also new with this version: a 

weather bar stretching across the top of your calendar. You can manually change the location, but 

by default, Office shows only one set of weather forecasts at a time. Another, more miscellaneous 

change: if you've begun to respond to an email, but saved it as a draft, the word "Draft" will appear 

in red in your inbox, next to the message (yes, just like Gmail). 

Peeks 
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With this version, the company is also introducing fly-over menus called Peeks, which show things 

like calendar appointments, to-do items and information about your contacts. To find these, look for 

the icons stacked on top of each other in the lower left corner of the screen. Mouse over the 

calendar icon, for instance, and you'll see a live, pop-up window that allows you to glance at your 

agenda without having to toggle between tabs to check your schedule. If you're wide open, you'll 

see a message saying you have no appointments; if you are booked, it'll tell you when. 

Social connectors 

Continuing this theme of showing as much 

information in one place as possible (without you 

having to click to a different screen): if you're 

reading an email from someone, you can click an 

arrow at the bottom of the screen to pull up the 

People Pane. While this pane isn't new (you could 

previously see your meetings with that person and 

also your email history), you can now glance at 

that person's social networking goings-on. For 

now, Outlook natively integrates with Facebook 

and LinkedIn, but not Twitter, for whatever 

reason. (There is, however, an API that makes this 

possible.) 

As we quickly learned, this feature is worthwhile 

mainly if you're on Facebook and also friends with 

the people you're conversing with. Obviously, you won't see updates from a business associate you 

aren't connected to on Facebook. At the same time, the LinkedIn integration is fairly useless unless 

someone is super active on that site; you'll only see recent activity, and even then, the tidbits tend 

to be uninteresting. After all, do you really need to know if someone just added someone else to 

their network? Really, Twitter integration would make this new feature so much more valuable: 

people are nosy enough to care about other people's tweets and fortunately, most of us don't 

bother to lock our accounts. 

SharePoint integration 

In news that will matter most to the IT guys reading this, Microsoft has improved the integration 

between Outlook and SharePoint so that SharePoint groups now have their own mailboxes. From 

here, you see documents stored on SharePoint without leaving Outlook. (To edit them, of course, 

you'll need to open the corresponding Office app.) We also appreciate that the reverse is also 

possible: you can drag and drop attachments into the docs folder for SharePoint and they'll upload 

to your team's site. 



Office 2013 - Public Preview of New Features Page 18 

OneNote 

 

The biggest news here is that OneNote, that receptacle for random thoughts and musings, will be 

available as a standalone, Metro-styled Windows 8 app. Though we caught a glimpse of it in an 

advance meeting with Microsoft, it wasn't available for testing during our preview period, so our 

impressions are more limited here. Rounding out the list, OneNote is also getting a full-screen view, 

auto-save, improved table tools, enhanced scribbling (nay, inking) functionality, integration with 

Outlook calendars, more efficient search and the ability to record audio alongside notes. 

Business apps 

Since most of our readers aren't suit-wearing business travelers so much as exceptionally well-

informed consumers, we're not going to delve into the new enterprise-grade features in nearly as 

much detail as Word, Outlook and other core apps. If corporate software rings your bell, though, 

we've got a quick rundown below of what's new: 

 Lync: Microsoft's messaging and video chatting client can now show up to five video streams 
simultaneously (previously, it could only handle multiple voices at once). By default, the 
active speaker will be promoted to the top. If more than five people are speaking, you can 
set Lync to prioritize whose video stream is being shown (those not featured will have photo 
thumbnails instead of a video stream). If you like, of course, you can also cherry pick whose 
video you're seeing. 

 Publisher: With Publisher, you can now import all your pictures to a single canvas, making it 
easy to experiment with possible images. Microsoft has also added text, shape and picture 
effects; a Mailings tab in the Ribbon; and the ability to use your own photos as page 
backgrounds. As with other apps we've talked about, you can share a URL with people 
where they can view your work in the browser. The new feature for easily adding photos 
from online sources applies here, too. 

 Visio: Office's standalone diagram creator gets updated shapes, as well as easier workflows 
for creating organizational charts and tweaking diagrams. Microsoft has also revised the app 
so that if you change shapes, you won't affect the entire diagram layout you've been 
working on. 

Versions and subscription plans 

So far, Microsoft hasn't revealed any pricing information for Office 2013, though it has outlined the 

different forms Office will take. There will, of course, be the web-based service Office 365 along with 
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the desktop Office 2013 suite. Additionally, Office will be available on ARM-based tablets running 

Windows RT -- albeit, with Word, Excel, PowerPoint and OneNote only. Finally, enterprises can 

purchase a server-specific version capable of hosting Exchange, SharePoint, Project and Lync. In 

cases such as those, businesses can choose cloud hosting, local servers or a combination of the two. 

Oh, and if you're wondering about Office for Mac, that will be available too, but Microsoft isn't ready 

to give the public a preview just yet. 

All told, here are the specific products Microsoft is previewing right now: 

 Office 365 Home Premium: Can be installed on up to five devices; users get an extra 20GB of 
SkyDrive storage; Word, PowerPoint, Excel, Outlook, OneNote, Access and Publisher are 
included. 

 Office 365 Small Business Preview: Can be issued to up to 10 users, with five installations 
each; adds "professional mail, shared documents and HD videoconferencing." 

 Office 365 ProPlus Preview: Can be issued to up to 25 users, with five installations each; 
includes Word, PowerPoint, Excel, Outlook, OneNote, Access, Publisher, InfoPath and Lync. 

 Office 365 Enterprise Preview: In addition to the above applications, this version includes 
SharePoint online and Lync Online. 

Wrap-up 

 

Sometimes it's the little things, like saving documents to SkyDrive, that charm us most. Even more 

than any actual feature in Office 2013, what left us most enchanted during our testing period was 

the moment we powered down our Series 7 tablet, turned it back on, launched Word and found the 

cursor exactly where we left it. The best thing about Office is not what it does better than Office 

2010, but how much more nimble it is in following you from device to device, from shut-down to 

start-up again. Beyond that, no one single feature of Office 2013 is dazzling, per se, but it doesn't 

matter: everything here, from YouTube embeds to the chart generator in Excel, works as promised 

and is intuitive to use. At the same time, the interface doesn't mark a radical departure from 
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previous versions, so even casual users with no use for PivotTables should be able to find their way 

around. 

The one caveat we feel compelled to offer is that although Office 2013 has been updated to keep 

pace with Windows 8, this is not some sort of magic bullet that will suddenly make Office a pleasure 

to use on tablet devices: while reading mode is fantastic and touch mode is a step in the right 

direction, we still wouldn't want to work with spreadsheets without the help of a mouse. That 

disclaimer aside, we've found very few faults with Office 2013 -- it's fast, polished and painless to 

use. 

 


